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Abstrakt  

 

Náplní této diplomové práce je vyhotovení geodetické a prostorové 

dokumentace úseku Zlatá stezka. Vybraný úsek se nachází u obce Strážný nedaleko 

hranic se SRN. 

 V první části této práce je popsána historie Zlaté stezky, především pak 

Vimperská větev, použité geodetické metody a representace dat v geografických 

informačních systémech. V této teoretické části diplomové práce jsou mimo jiné 

uvedeny druhy digitálních modelů terénu a sběr dat pro jejich tvorbu. Poslední 

kapitola je věnována popisu programů, které byly použity pro zpracování diplomové 

práce. 

 Druhá část diplomové práce se věnuje zpracování samotných výsledků. Je zde 

popsán způsob získání dat – geodetické zaměření v terénu a jejich výpočet. Další 

kapitola je věnována tvorbě digitálních modelů terénu (model TIN a rastrový model). 

Výsledné DMT byly porovnány z hlediska přesnosti naměřených a získaných dat. 

Poslední kapitola se zabývá možnými vizualizacemi DMT v prostředí ArcScene. 

 

 

Klí čová slova: Zlatá stezka, geodézie, digitální model terénu, geografické 

informační systémy (GIS), GNSS, geostatistika 

 

 

 

 

 

 

 

 

 

 



 

 
 

 

Abstract 

 

The aim of this thesis is the original surveying and spatial documentation 

section of the Golden Trail. The selected section is located near the village guard 

near the border with Germany.  

In the first part of this thesis describes the history of the Golden Trail, 

especially Vimperk branch, used geodetic methods and data representation in 

geographic information systems. In the theoretical part, inter alia, the types of digital 

terrain models and data collection for their work. The last chapter is devoted to 

describing the programs that were used for processing the thesis.  

The second part of the thesis deals with the processing of the results 

themselves. There is described a method of obtaining data - geodetic surveying in the 

field and their calculation. Another chapter is devoted to the creation of digital 

terrain models (model TIN and grid model). The resulting DTM were compared in 

terms of accuracy of the measured and the data obtained. The last chapter deals with 

possible visualization environment DTM in ArcScene  

 

 

Key words: Gold Trail, Geodesy, Digital Terrain Model, Geographical Inforamtion 

System (GIS), GNSS, Geostatistic 
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1 Úvod 

 Zlatá stezka – kdysi po této stezce putovaly karavany z německého Pasova do 

Čech, přivážející s sebou sůl, koření, látky a jiné zboží. Čilý obchodní ruch zde kvetl 

prakticky celý středověk až do třicetileté války. Po nástupu Habsburků na trůn 

získala monopol rakouská sůl a Zlatá stezka upadla v zapomnění. Některé její úseky 

se časem změnily ve státní silnice, jiné naopak zarůstaly lesem a staly se 

nepřístupnými. Často bývaly zbytky Zlaté stezky využívány pašeráky, ale obchod se 

už zpátky nikdy nevrátil. Po druhé světové válce se část Zlaté stezky ocitla 

v pohraniční zóně, kam byl zákaz vstupu veřejnosti. A možná díky tomu se 

dochovaly některé významné fragmenty až do dnešní doby. 

 Od začátku 90. let minulého století byla postupně Zlatá stezka na našem 

území detailněji zkoumána. Asi největší zásluhu na výzkumu mají F. Kubů a           

P. Zavřel, neboť se výzkumu všech tří větví Zlaté stezky na našem území věnovali 

téměř 15 let. Díky jejich práci byly úseky Zlaté stezky nejen archeologicky 

prozkoumány, ale také geodeticky zaměřeny. V současné době dokončují průzkum 

Zlaté stezky na německém území. 

 Novým přínosem pro uchování dat a presentaci výsledků o Zlaté stezce by 

mohlo být využití geografických informačních systémů (GIS). Především 3D modely 

území se zaměřenými úseky by vhodně doplňovaly tento rozsáhlý výzkum a přiblížili 

jej širší veřejnosti. 
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2 Cíle práce 

 Hlavním cílem diplomové práce bylo využít geografické informační systémy 

(GIS) ke zdokumentování současného stavu úseku Zlaté stezky v okolí obce Strážný 

s následnou tvorbou digitálního modelu terénu a 3D vizualizace. Vedlejším cílem 

bylo posouzení přesnosti naměřených výškopisných dat s výškopisem dat získaných 

od Českého úřadu zeměměřického a katastrálního (ČÚZK).  

 Jedním z důvodů, proč použít GIS při zdokumentování Zlaté stezky, je jeho 

všestrannost. Výsledky získané z dostupných či nově získaných dat lze snadno 

spravovat a upravovat pro další použití. 

 Cíli diplomové práce bylo: 

1) získat a upravit data pro využití tvorby digitálních modelů terénu, 

2) z dostupných dat vytvořit digitální modely terénu různými typy representace, 

3) posouzení přesnosti výškopisu naměřeného a výškopisu získaného od ČÚZK, 

4) tvorba rozsáhlejšího modelu terénu a jeho vizualizace, 

5) vyhodnotit přínos využití GIS.   
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3 Historie Zlaté stezky 

 Názvy „Zlatá stezka“ a „Zlatá cesta“ označovaly od počátku 16. století tři 

staré komunikace, které vedly z Německa do Čech a které překračovaly pohraniční 

hvozdy Šumavy a Českého lesa. První z nich vedla z Norimberka přes Weiden, 

Tachov a Plzeň do Prahy, druhá z Pasova a Vilshofenu přes Grafenau do 

Kašperských Hor, Sušice a Klatov. Nejvíce však jméno „Zlatá stezka“ utkvělo na 

systému obchodních cest, které od raného středověku spojovaly Pasov s českými 

zeměmi a po nichž proudila především sůl ze Solnohradska na sever (Kubů, Zavřel 

2007). Její systém se postupně rozšiřoval a ve 14. století již tvořily stezku tři hlavní 

linie. Poblíž českých hranic v oblasti Freyungu a Waldkirchenu se vyčlenily tři 

základní trasy, a to kašperskohorská, vimperská a prachatická větev (Kuna et al. 

2004). 

• Dolní Zlatá stezka – nejstarší a nejvýznamnější větev, doložená od počátku 

11. století. Spojovala Pasov s Prachaticemi přes Salzweg, Strasskirchen, 

Leoprechting, Kringell, Grossthansteig, Vendelsberg, Aussernbrünst, 

Deching, Ernsting, Oberleinbach, Schiefweg příp. Waldkirchen, 

Böhmzwiesel, Fürholz, Grainet, Leopoldsreut, Bischofsreut, České Žleby, 

Volary, Blažejovice, Albrechtovice a Libínské Sedlo (Kubů, Zavřel 2007). 

• Střední Zlatá stezka – doložená od počátku 14. století. Tato větev spojovala 

Pasov s Vimperkem přes Ernsting, Wotzmannsreut, Reut, Winkelbrunn, 

Hinterschmiding, Herzogsreut, Philippsreut, Strážný, Žlíbky, Havranku, 

Horní Vltavici, Kubovu Huť, Arnoštku, Korkusovu Huť a Solnou Lhotu 

(Kubů, Zavřel 2007). 

• Horní Zlatá stezka – vznikla v polovině 14. století. Spojovala Pasov 

s Kašperskými Horami přes Salzgattern u Vendelsbergu, Röhrnbach, 

Harsdorf, Freyung, Kreuzberg, Mauth, Finsterau, Bučinu, Kvildu, Horskou 

Kvildu, Zhůří a Červenou nebo Kozí Hřbety (Kubů, Zavřel 2007). 

 Existuje řada nepřímých dokladů, že šumavské přechody byly využívány již 

v pravěku (Beneš 1995), ale první historické zprávy o ní máme z 11. století. 

Německý král Jindřich II. (později římský císař) daroval listinou z roku 1010 
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pasovskému ženskému klášteru Niedernburg mýtné poplatky na cestě do Čech a 

někdy na konci 11. století přenechal český vévoda Vratislav II. obdobné poplatky na 

cestě z Prachatic do Pasova Vyšehradské kapitule. Obě obdarované církevní instituce 

spravovaly stezku v prvních stoletích její existence. Funkci Niedernburgu již od 12. 

století postupně přebíralo pasovské biskupství a na české straně vystřídala po 

husitských válkách vyšehradskou kapitulu světská moc, především významný 

jihočeský rod Rožmberků (Praxl et al. 2011).  

 Hlavním obchodním artiklem na Zlaté stezce byla nesporně sůl. České země 

jí měly nedostatek a poptávka po ní byla značně vysoká (Starý 2002), neboť to byl 

mj. i jediný konzervační prostředek na potraviny. Sůl se dovážela ze solných ložisek 

ve východoalpské oblasti v Reichenhallu a Halleinu přepravovala se po řece Inn do 

Pasova a odtud na hřbetech soumarských koní po Zlaté stezce přes Šumavu do Čech. 

(Praxl et al. 2011) Kromě soli se z Pasova do Čech vozily drahé látky, jižní plody, 

koření a víno (Andreska 1994) a opačným směrem hlavně obilí a dále slad, med, 

chmel, vlna, kůže, pivo a další potravinářské produkty (Pilát 1947). 

 Konec obchodu na Zlaté stezce je datován ke konci 17. století, jak se již o 

tom zmiňuje Teplý (1948) „… třicetiletá válka zasadila i starým komunikacím od 

Pasova do Čech smrtelnou ránu. Brzy po vestfálském míru postaven v Linci přes 

Dunaj velký most, Vyšebrodští Cisterciaci počali mýtit lesy mezi Vyšším Brodem a 

Leonfeldem, stará cesta tímto hvozdem nejenom ku klášteru Světlé, ale i přes Linec 

k Welsu pro válečnou důležitost dobře spravena a tak soumaři i jinší cestovníci od 

jihu, zejména se solí od Haleinu, Solnohradu zvolili s opomenutím veliké zajížďky 

pasovské kratší a méně hornatou silnici Linec – Krumlov – Budějovice a již kolem 

roku 1672 – 1680, kdy v Budějovicích rozšířena stará solnice Salzhaus.“ 

 Zlatá stezka představuje rozsáhlý archeologizovaný prvek kulturní krajiny, 

který v mnohém předznamenává rozvoj silniční sítě v tereziánském období. Trasy 

Zlaté stezky jsou antecedentem řady dnešních šumavských silničních úseků. Se 

Zlatou stezkou je spojen vznik řady významných areálů, dosud patrných, např. 

Volarských šancí nebo opevnění u Kořenného. Pozoruhodný je i systém strážních 

hrádků, situovaných v blízkosti komunikace (Hrádek na Stožecké skále, Kunžvart) 

(Kuna et al. 2004). 
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Obr. 3.1 Průběh tří větví Zlaté stezky (Kubů, Zavřel 2007) 
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3.1  Vimperská větev 

 Český název města Vimperk je odvozeninou od původního německého názvu 

Winterberg (Zimní hora) přes mezitvary Wimberg a Vimberk, používané ještě běžně 

v 19. století. Německé místní názvy, které obsahují slovo Winter (zima, zimní), 

signalizovaly obvykle severní polohu sídliště nebo polohu, kde se dlouho držel sníh. 

(Kubů 2005) 

 Vimperská obchodní cesta je poprvé zmiňována roku 1312. Je však 

pravděpodobné, že to byla cesta mnohem starší, jak nasvědčuje hradiště Věnec 

z doby halštatské a laténské a jiná hradiště v údolí Volyňky. V polovině 13. století 

postavil zvíkovský purkrabí Burghardt, současník Hirzův, na královském lénu hrad 

Vimperk, německy Winterberg, Zimní hora. Hrad stál při obchodní cestě. Při jeho 

úpatí vzniklo záhy stejnojmenné tržiště, které získalo roku 1479 městská práva. 

Koncem 13. století byl na této stezce při hranici Čech postaven strážní hrad 

Königswarte, odtud Kunžvart, nyní Strážný. Na německé straně Šumavy byl na této 

stezce okolo roku 1200 postaven hrad Wolfstein, u něhož vznikla obec a později 

město Freyung, „svobodné město“ osvobozené od poplatků při kolonizaci. Tak 

získala vimperská cesta hned tři ochranné hrady, které dbaly o její bezpečnost. 

Vimperský solný obchod nedosahoval objemu prachatického, ale i tak byl velice 

významný (Andreska 1994). 

 Solní obchod vynášel a logicky kvůli němu docházelo k mnoha sporům. 

Prachatice, nejvýznamnější české město na Zlaté stezce, hleděly na Vimperk jako na 

svého nežádoucího konkurenta a snažilo se jej se střídavými úspěchy a neúspěchy 

v jeho podnikání omezit. Podle dohody z roku 1502 si soumaři mohli vybrat, zda 

svůj náklad soli dopraví do Prachatic nebo do Vimperka, a nikdo jim v tom nesměl 

bránit. Vimperští měli právo na užívání Zlaté stezky zakotveno i ve svém městském 

privilegiu krále Vladislava Jagellonského z roku 1479 (Kubů 2005). 

 Dovezená sůl z Pasova nezůstala ve Vimperku dlouho. Putovala odtud dále 

do celého Prácheňského a Bechyňského kraje. Z roku 1592 se zachovalo ve Státním 

oblastním archivu v Třeboni v pobočce Český Krumlov několik zajímavých dopisů, 

které zasílal bechyňský hejtman Jiřík Homout z Harasova vimperskému hejtmanu. 
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V prvním zachovaném, z února 1592, žádal vimperského hejtmana Jakuba 

Roudnického o odeslání 12 prostic soli, protože „veliký nedostatek strany soli na 

obročnici jest“. V červenci 1593 se na Český Krumlov obrátil s dopisem vimperký 

měšťan Adam Prykhier, který si stěžoval, že v roce 1591 zaslal 12 prostic soli, za 

kterou mu nebylo dosud ještě zaplaceno (Starý 2002). 

 Po zákazech dopravy bavorské soli do Čech v druhé polovině 16. století a pak 

znovu v době pobělohorské, doprava soli po vimperské cestě upadala. Nikdy už 

nedosáhla bývalého významu (Andreska 1994). Trasy jednotlivých větví Zlaté stezky 

se Habsburkové potom pokoušeli využít při budování novodobé silniční sítě, ale jako 

vhodná se ukázala pouze Vimperská větev, dnes téměř totožná s mezinárodní silnicí 

v Německu přes hraniční přechod (Praxl et al. 2011). 

3.2 Řešené území 

 Velké a zachované úseky pozůstatků Zlaté stezky pojmenovali Kubů a Zavřel 

(2007) ve své metodice tzv. „systémy“. Vimperskou větev rozdělili cekem na 3 

významné úseky: Kubohuťský systém mezi Arnoštkou a Kubovou Hutí, Žlíbský 

systém jihozápadně od Horní Vltavice a Systém na Obecním vrchu na stejnojmenné 

hoře u Strážného. 

3.2.1 Systém na Obecním vrchu 

 Systém na Obecním vrchu je součástí posledního úseku vimperské větve na 

českém území. Celkově je dlouhý přes tři kilometry a prochází velice členitou 

krajinou mezi obcí Strážný a stání hranicí mezi Českou republikou a Spolkovou 

republikou Německo. Tento úsek byl celý v hraničním pásmu a prakticky více jak 

čtyřicet let veřejnosti nepřístupný. Díky tomu se zde zachovalo mnoho cenných 

pozůstatků Zlaté stezky. 

 Výzkum ukázal, že původní trasa Zlaté stezky překračovala za dnešní osadou 

Strážný horské sedlo mezi oběma vrcholky Obecního vrchu a směřovala tak přímou 

cestou na jih do prostoru dnešního hraničního přechodu Strážný/Philippsreut 

k zemské hranici. Na konci své existence (17. a počátek 18. století) potom Zlatá 

stezka Obecní vrch obcházela přibližně po trase dnešní žlutě značené turistické cesty 

ze Strážného ke státní hranici. Tato novější trasa je zachycena na mapě z roku 1736, 
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 a původní starší trasa je dokumentována mohutnými pozůstatky stezky na Obecním 

vrchu (Kubů, Zavřel 2007). 

 Na Obecním vrchu se dochovaly rozsáhlé pozůstatky Zlaté stezky. Jedná se o 

následující úseky pozůstatků: 

 VII 1  – nejrozsáhlejší nesporně dochovaný pozůstatek na VII. úseku 

vimperské větve tvoří společně s nesporně dochovanými pozůstatky VII 2 a VII 3 

Systém Obecní vrch. Rozkládá se od severního úpatí Obecního vrchu přes horské 

sedlo mezi jeho oběma vrcholy až téměř k jižnímu úpatí, kde končí úsek VII 3. 

Systém je 800 metrů dlouhý, místy až čtyřkolejný, a některé jeho koleje dosahují 

úctyhodných rozměrů. Zvláště impozantní, 55 metrů dlouhá kolej, která na vrcholu 

stoupání přetíná sedlo mezi oběma vrcholy Obecního vrchu, patří nesporně k vůbec 

nejpůsobivějším pozůstatkům Zlaté stezky na českém území. Je až deset metrů široká 

a až pět metrů hluboká. Ostatní koleje tohoto úseku jsou většinou jeden až tři metry 

široké a jeden až dva metry hluboké. Základní linie tohoto úseku je doprovázena 

řadou spojek mezi jednotlivými kolejemi, zkratek a odboček. Celý úsek je po celé 

své délce velmi dobře dochován, pravděpodobně také díky skutečnosti, že tato trasa 

byla již někdy v 17. století opuštěna a nahrazena západněji položenou trasou novou 

(Kubů, Zavřel 2007). 

 VII 2  – pozůstatek novější trasy, která obcházela západní vrchol Obecního 

vrchu. Začíná v prostoru bývalého signálního hraničního zátarasu z doby socialismu, 

asi 350 metrů západně od starší silnice z Vimperku a Strážného k státní hranici, a 

sice na místě, kde se novější, turisticky značená cesta začíná stáčet na jih, a odkud 

potom stoupá až na malý vrcholek s bývalou kapličkou. Šíře tohoto úseku dosahuje 

až čtyř metrů, a hloubka kolísá mezi jedním a dvěma metry. Cesty je místy lemována 

nízkými kamennými zídkami, a příležitostně lze vidět i kameny, které mohou 

pocházet ze starého dláždění. Na vrcholu stoupání, na křižovatce turistických cest je 

tento úsek přerušen, brzy však pokračuje dále a za stálého klesání se stáčí po úpatí 

Obecního vrchu na jih. Potom se pozvolna přeměňuje v lesní cestu. Celkově je tento 

úsek dlouhý asi 400 metrů (Kubů, Zavřel 2007). 

 VII 3  – navazuje na jižním úpatí Obecního vrchu na úsek VII 1. Jedná se o 
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dvě velmi dobře dochované úvozové cesty, které jsou hluboce zaříznuty do lesního 

terénu mezi malou kamenitou příčnou zdí na severu a seníkem na okraji lesa na jihu. 

Obě koleje běží souběžně a dole u seníku se znovu spojují. Rovné úseky se tu střídají 

se zatáčkami. Levá kolej je hlubší, pravá širší, a obě zřetelně klesají dolů jižním 

směrem. Celý úsek je celkově dlouhý asi 100 metrů. Levá kolej je jeden až dva metry 

široká a do tří metrů hluboká, a pravá kolej je jeden až čtyři metry široká a do dvou a 

půl metru hluboká. Tento úsek je nejlepším příkladem zřetelně dochovaného 

pozůstatku staré cesty (Kubů, Zavřel 2007). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Obr. 3.2 Systém na Obecním vrchu (Kubů, Zavřel 2007) 
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4 Použité geodetické metody 

 V následujících kapitolách jsou zmíněny geodetické metody, které byly 

použity při měření v terénu. 

4.1 Polygonové pořady 

 Polygonový pořad je definován dle ČSN 73 0401 jako spojnice vrcholů 

prostorové lomené čáry. Je zaměřen pomocí měřených délek a vodorovných úhlů. 

Švec, Hánek (2006) říká, že polygonový pořad je lomená čára spojující dva měřické 

body. Ve vrcholech lomené čáry leží polygonové body. Přímé spojnice 

polygonových bodů jsou polygonové strany. V polygonových pořadech se měří 

délky všech stran a levostranné vrcholové úhly na všech polygonových bodech. 

 Z hlediska délky stran se dělí polygonové pořady s dlouhými stranami (200 

až 1500 m) a na pořady s krátkými stranami (50 až 200 m). 

 Polygonovými pořady se určují body PBPP (podrobné body polohového 

pole). Zhušťovací body se přitom připojují výhodně na body základního bodového 

pole. Ostatní PBPP se připojují na body základního bodového pole, zhušťovací body 

a na ostatní body PBPP. Polygonový pořad musí být oboustranně připojený a 

oboustranně orientovaný. Polygonové pořady kratší než 1,5 km mohou být 

orientované jednostranně popřípadě i neorientované (vetknuté). Neorientované 

pořady mohou mít nejvýše 4 strany a dovolují-li to okolnosti, alespoň na jednom 

z vrcholů se zaměří orientační úhel (Ratiborský 2000). Geometrické parametry a 

kriteria přesnosti polygonových pořadů:  

 

Připojovací 
body 

Mezní délka 
strany [m] 

Mezní délka 
pořadu s [m] 

Mezní odchylka v uzávěru pořadu 
Určovaný bod 

Úhlová [mgon] Polohová [m] 
ZBP, body GPS 200 - 1500 4500 20(n+2)1/2 0,0018(Σs)1/2+0,02 ZhB 

ZBP, ZhB 200 - 1500 5000 25(n+2)1/2 0,0025(Σs)1/2+0,04 Ostatní PBPP 
ZBP, ZhB 50 - 400 3000 100(n+3)1/2 0,005(Σs)1/2+0,04 Ostatní PBPP 

Ostatní body, 
ZBP, ZhB 

50 - 400 1500 100(n+3)1/2 0,005(Σs)1/2+0,10 Ostatní PBPP 

Tab. 4.1 Přesnost polygonových pořadů (Ratiborský 2000) 

pozn.: n – počet bodů pořadu včetně bodů připojovacích 

         Σs – součet délek stran pořadu 
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Použitý polygonový pořad: 

• Oboustranně připojený a oboustranně orientovaný polygonový pořad 

- jsou známé souřadnice počátečního i koncového bodu a měřené orientace    

  na obou bodech 

 

 

 

 

Obr. 4.1 Oboustranně připojený a orientovaný polygonový pořad     

      (Laciná 2011) 

4.2 Tachymetrie 

 Slovo tachymetrie (dříve tacheometrie) vzniklo složením dvou řeckých slov 

(tacheo – rychlost a metrein – měřit). Čili do češtiny přeloženo rychloměřictví. 

Universálnost v názvu označuje, že její využití je mnohostranné. Je nejpoužívanější 

metodou, protože při jejím použití lze určit nejen nadmořskou výšku podrobného 

bodu, ale i jeho polohu (Chamout, Skála 2003). Jednoduše řečeno, podrobný bod je 

určen prostorově jediným zaměřením. Tachymetrie je prakticky polární metoda se 

současným určením výšky bodu. Měřené prvky jsou: vodorovný směr, zenitový úhel 

a vzdálenost (Hauf 1982). Velmi často se používá nejen pro vyhotovení 

výškopisného, ale zároveň polohopisného plánu, zejména pro potřeby investiční 

výstavby, kdy lze připustit nižší přesnost v poloze (Blažek, Skořepa 2006).

 V současné době se nejčastěji používá k tachymetrii totální stanice, což je 

v podstatě elektronický teodolit, který vzdálenost měří pomocí elektronického 

dálkoměru a úhly jsou odečítány pomocí elektronického systému na kódových 

kruzích. Velikost území, které lze zaměřit z jednoho stanoviska, je omezeno 

dosahem totální stanice, tvarem terénu, hustotou porostu nebo zástavby. Tato metoda 

se často používá pro doměření zakrytých částí území, které nebylo možné vyhodnotit 

například fotogrammetricky (pod vegetací).  

4.3 Globální navigační družicový systém 

 Globální navigační družicový systém (angl. Global Navigation Satellite 

System – GNSS) je souhrnný termín k označení globálních družicových systémů.  
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Tyto systémy nám umožňují určit přesnou polohu a čas kdekoliv na Zemi i nad 

Zemí. Díky své přesnosti a rychlosti měření se dnes GNSS velmi často používá i 

v geodézii. V ČR se využívá několik navigačních systémů. 

• Navstar GPS 

 Navstar GPS (angl. Global Position System) je vojenský navigační družicový 

systém provozovaný Ministerstvem obrany Spojených států amerických. Vývoj 

probíhal od konce 50. let 20. století a navazoval na námořní navigační systém 

TRANZIT. V 80. letech bylo rozhodnuto o uvolnění systému pro civilní účely. 

Významným datumem je 2. května 2000, kdy byl zrušen výběrový přístup SA (angl. 

Selective Availability), který snižoval horizontální i vertikální přesnost pro civilní 

(neautorizované uživatele). Avšak Spojené státy si ponechaly právo omezit sílu nebo 

přesnost signálu GPS nebo dokonce veřejný přístup zamezit úplně např. v době války 

(Čábelka 2008). 

• GLONASS 

 GLONASS (rus. Globalnaja navigacionnaja sputnikovaja sistěma) je pasivní 

dálkoměrný družicový radiový navigační systém, který je nyní spravován Ruskými 

vojenskými kosmickými silami pro potřeby ruské vlády. GLONASS je obdobou 

americké GPS a od roku 1995 je k dispozici i civilním uživatelům (Rapant 2002b). 

• Galileo 

 Galileo je plánovaný autonomní evropský navigační družicový systém. Jeho 

výstavbu zajišťuje Evropská unie (EU) representována Evropskou komisí (EC) a 

Evropskou kosmickou agenturou (ESA). Jelikož Navstar GPS i GLONASS jsou 

vojenské navigační systémy bez záruky, že ve výjimečných situacích budou plně 

funkční i pro civilní využití, je systém Galileo navržen jako projekt řízený a 

spravovaný civilní správou. Galileo má poskytovat vyšší přesnost dostupnou všem 

uživatelům a větší pokrytí signálem (Čábelka 2008). Prvotní spuštění systému je 

plánováno na rok 2014/2015. Plná dostupnost a kvalita poskytovaných služeb se 

předpokládá v letech 2019/2020 při plném zprovoznění systému. 
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4.3.1 Rychlá statická metoda 

 Pro zjištění souřadnic orientací pomocí GNSS byla použita tzv. „rychlá 

statická metoda.“ Tato metoda je ekonomičtější variantou statické metody měření a 

je pravděpodobně nejpoužívanější metodou v geodézii. Doba observace na bodech je 

zkrácena na 10-30 minut podle typu přístroje, vzdálenosti mezi přijímači a 

konfiguraci družic v okamžiku měření (Rapant 2002b).  

4.3.2 CZEPOS 

 Česká síť permanentních stanic pro určování polohy – CZEPOS umožňuje 

uživateli zpřesnění určování polohy při používání GNSS na území České republiky. 

Děje se tak pomocí permanentních stanic, na kterých jsou kontinuálně prováděna 

měření signálů navigačních systémů GNSS. Naměřená a odvozená data (korekce) 

jsou distribuována uživatelům. Současně síť zprostředkovává služby pro zpřesnění 

polohy určené aparaturou uživatele (Vilímková 2006). 

 CZEPOS obsahuje 28 permanentních stanic rovnoměrně rozmístěných ve 

vzdálenostech cca 60 km. Celkový počet zahrnuje 28 stanic umístěných na území ČR 

a 27 příhraničních stanic státních sítí GNSS sousedních států. Na území České 

republiky je 23 stanic CZEPOS, které jsou ve správě Zeměměřického úřadu a jsou 

umístěné na budovách katastrálních úřadů resp. pracovišť a dále 5 externích stanic 

spravovaných vědeckými a akademickými pracovišti (ČÚZK 2013).  

 

Obr. 4.2 Mapa referenčních stanic CZEPOS (ČÚZK 2013) 
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 Referenční stanice ve správě Zeměměřického úřadu, jsou vybaveny přijímači 

Leica GRX 1200+ GNSS, které umožňují příjem signálů družicových systémů GPS 

NAVSTAR i GLONASS a jsou připraveny na příjem signálů z družic GALILEO. 

Přijímače zajišťují permanentní sběr dat 24 hodin denně s intervalem záznamu 1 

vteřina, zálohování dat na compactflash kartu přijímače a distribuci dat na centrální 

servery CZEPOS prostřednictvím zabudovaného ethernet portu. Přijímače zajišťující 

data pro postprocessing jsou na server přenášena v pravidelných hodinových 

intervalech formou hodinových souborů, data pro služby v reálném čase jsou 

přenášena bezprostředně po pořízení formou datových paketů (ČÚZK 2013). 
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5 Geografické informační systémy 

 Pro GIS (angl. Geographical Inforamtion System) neexistuje jednotná 

definice. Velice často se používají definice (Burrough 1986; Voženílek 1998). 

Břehovský, Jedlička (2006) definují GIS jako informační systém, který pracuje 

s prostorovými daty. Naproti tomu Rapant (2002a) chápe GIS ve třech úrovních: GIS 

jako software; GIS jako konkrétní aplikaci; GIS jako informační technologii. Asi 

nejpřesnější definici a zároveň nejlépe pochopitelnou najdeme na oficiálních 

stránkách společnosti ArcData Praha (2013), která zní: „Geografický informační 

systém je organizovaný souhrn počítačové techniky, programového vybavení, 

geografických dat a zaměstnanců navržený tak, aby mohl efektivně získávat, ukládat, 

aktualizovat, analyzovat, přenášet a zobrazovat všechny druhy geograficky 

vztažených informací“. Jiná, velmi často používaná definice je od společnosti ESRI 

(Enviromental Systems Research Institute) (2013): „GIS je organizovaný soubor 

počítačového hardwaru, softwaru a geografických údajů (naplněné báze dat) 

navržený na efektivní získávání, ukládání, upravování, obhospodařování, 

analyzování a zobrazování všech forem geografických informací.“ Pro upřesnění 

můžeme uvést definici obráceně, co není GIS? Není to počítačový systém na 

vytváření map, ačkoliv mapy vytvářet může, neboť GIS je hlavně analytický nástroj. 

A GIS také není CAD (ačkoliv původní myšlenka z CADu vzešla). CAD (Computer 

Aide Drawning/Design) je většinou používán pro vytváření nových objektů, kdežto 

GIS slouží k analýze a modelování existujícího světa, včetně historie (Břehovský, 

Jedlička 2006). 

5.1 Representace dat v GIS 

 V zásadě existují dva základní způsoby representace údajů v GIS, vycházející 

z protikladných možností modelování prostoru: 

a) explicitní (rastrová) representace, označována i jako mozaiková (tesselační), 

která vychází z modelování pomocí polí – absolutního modelování prostoru 

b) implicitní (vektorová) representace, která vychází z objektového – relativního 

modelování prostoru (Tuček 1998). 
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5.1.1 Rastrová representace 

 Základním stavebním prvkem je u rastrové struktury tzv. buňka (cell, pixel). 

Buňky jsou organizovány do tzv. mozaiky. Jednotlivé buňky obsahují hodnoty 

(values) zastupující zkoumanou lokalitu (Břehovský, Jedlička 2006). Mozaikový 

model můžeme z prostorového hlediska volně definovat jako prostorově na sebe 

navazující množinu dvoj- nebo trojrozměrných elementů různého tvaru a velikosti, 

které kompletně vyplňují zkoumanou plochu (Tuček 1998). Rastrovou representaci 

můžeme rozdělit na: 

• pravidelné rastry – při kterých je tvar polí přesně definovaný a vždy stejný 

(čtverec, obdélník, šestiúhelník, trojúhelník). Tyto rastry se dále dělí na: 

a) rastry se stejnou rozlišovací úrovní – pole stejně velká, 

b) rastry s nestejnou rozlišovací úrovní nebo hierarchickou strukturou – velikost 

polí se definovaným způsobem mění. 

• nepravidelné rastry – při kterých se vytvářejí pole různého tvaru i velikostí 

(Worboys 1995 in Tuček 1998). 

 Nejpoužívanější rastrovou representací je pravidelná čtvercová mřížka, a to 

především ze tří praktických důvodů: 

• je kompatibilní se strukturami datových struktur používaných ve výpočetní 

technice (matice), 

• je kompatibilní s řadou hardwarových zařízení pro záznam a výstup dat 

(skenery, tiskárny, plotry), 

• je kompatibilní s kartézskými souřadnicovými systémy (Voženílek 1998). 

 Každá pravidelná mozaika se může dělit na podrobnější rastrové uspořádání, 

tzv. vnořených buněk. Avšak pouze čtvercová buňka si rekurzivním dělením 

zachovává tvar i orientaci. Trojúhelníkové buňky dělením zůstávají stále 

trojúhelníkové, ale orientace již není u všech nových buněk stejná. Šestiúhelníkové 

buňky nelze dělením zmenšit tak, aby si ponechaly stejný tvar (Kolář 2003). Oproti 

tomu hlavní výhodou pravidelné hexagonální mřížky je, že středy všech sousedních 

od středu dané buňky jsou stejně vzdálené. Tato symetrie činí tento model výhodným 
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pro některé analytické funkce. Toto je nemožné na čtvercové mřížce, kde diagonální 

sousedé nejsou ve stejné vzdálenosti jako sousedé ve čtyřech základních směrech od 

centrální buňky (Tuček 1998). 

 Pro popis některých prvků a jevů se s výhodou používá mozaiky, tvořené 

buňkami nejen různé velikosti, ale i různého tvaru. Pro geografické aplikace se 

obvykle používají mozaiky složené z trojúhelníků nebo nepravidelných 

mnohoúhelníků. Nepravidelné rastrové modely jsou však složitější na tvorbu i práci 

než pravidelné rastry. Jsou sestaveny vždy jen pro určitý druh dat a analytické 

zpracování (Kolář 2003). Nepravidelné rastry jsou vhodné pro representaci terénu a 

povrchu. Nejčastěji využívají trojúhelníky s proměnlivou velikostí a tvarem, tzv. 

nepravidelní trojúhelníkové sítě (angl. Triangulated Irregular Networks) TIN. TIN 

representuje povrch jako soubor trojúhelníků, které jsou definovány třemi body 

umístěnými kdekoliv v prostoru a pro tyto trojúhelníky uchovává topologické vztahy 

(Břehovský, Jedlička 2006). 

5.1.2 Vektorová representace 

 Pro vektorová data je charakteristický zprostředkovaný vztah mezi 

prostorovou a informační složkou datového modelu. Prostorová i tematická 

informace je vázána k identifikátoru objektu, který je základním prvkem vektorových 

dat (Voženílek 1998). Ve vektorovém datovém modelu se pro popis geometrických 

vlastností geoprvků používají lineární geometrické prvky, tzv. vektory. Tyto 

vlastnosti jsou znázorněny pomocí tří základních geometrických prvků: 

• bod – jako vektor nulové čáry (vektor, u něhož splyne počáteční a koncový 

bod). 

• linie – jako otevřená posloupnost vektorů. U linie rozlišujeme počáteční a 

koncový bod, které se označují termínem uzel (nod) a mezilehlé body, 

vrcholy (vertex). 

• plocha – representována svojí hraniční linií, která je uzavřená, popsaná 

uzavřenou posloupností vektorů, resp. linií (Rapant 2002a). 

Stejně jako u rastru, tak i u vektoru máme několik možností representace dat. 
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Špagetový model 

 Nejjednodušší vektorový model pro geografické údaje. Princip vychází 

z digitalizace map, kde se každý objekt na mapě representuje jedním logickým 

záznamem v souboru a je definovaný jako řetězec X, Y souřadnic (Břehovský, 

Jedlička 2006). Použití špagetového modelu je omezeno jen na jednoduché úkoly 

počítačové kartografické produkce. Špagetový model není vůbec vhodný pro 

prostorové analýzy, protože jakákoliv informace o vztazích mezi objekty, jež je 

zřejmá při pohledu na původní analogový dokument, se musí odvozovat výpočtem 

(Kolář 2003). 

Topologický model 

 Nejpopulárnější metodou jak zachovat vztahy mezi entitami, je explicitně 

zaznamenat, zapsat „souvislostní“ informaci do datových souborů. Základním 

logickým prvkem, entitou linie, v topologickém smyslu je hrana. Hrana začíná a 

končí v průsečících s jinou hranou, v uzlovém bodě. Každá individuální hrana má 

zaznamenané označení a souřadnice svých dvou uzlových bodů. Dále je 

zaznamenaný identifikátor nebo jméno každého z polygonů napravo a nalevo od 

hrany (Tuček 1998), což velice usnadňuje kontrolu konzistence a detekci chyb a 

usnadňuje také provádění některých analýz, jako např. analýzy sítí (Rapant 2002a). 

Hierarchický model 

 Tento model odstraňuje neefektivnost při vyhledávání v jednodušším 

topologickém modelu pomocí ukládání v logicky hierarchické podobě. Například při 

vyhledávání sousedních polygonů se použijí jenom data pro polygony a linie 

(Břehovský, Jedlička 2006). 

5.1.3 Porovnání rastrové a vektorové representace 

 Obecně lze říci, že vektorová representace se více hodí pro dokumentaci 

objektů a presentaci čar. Kdežto rastrová je vhodnější pro prostorovou proměnnost a 

presentaci ploch. 
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Tab. 5.1 Porovnání rastrové a vektorové representace 

         (Kolář 2003, Tuček 1998, Voženílek 1998) 

5.2 Digitální model terénu 

 Digitálním modelem terénu (DMT) se většinou rozumí prostorový 

geometrický popis reliéfu terénu. Na tomto reliéfu lze dále modelovat a popisovat 

nejrůznější informace, jak je tomu např. u topografických map. Tedy umístění 

přírodních i umělých objektů, hranice správních celků, hranice povodí, apod.  

(Šindelář 1999). Prostorové modely můžeme rozdělit: 

• digitální model reliéfu (angl. Digital Terrain Model) 

• digitální model povrchu (angl. Digital Surface Model) 

• digitální výškový model (angl. Digital Elevation Model) 

Digitální model reliéfu 

  Digitálním modelem reliéfu se rozumí zemský povrch bez vegetace a staveb.  

Definice DMR v terminologickém slovníku Českého úřadu zeměměřického a 

katastrálního (2013) zní: „Digitální model terénu/reliéfu je digitální reprezentace 

reliéfu zemského povrchu v paměti počítače, složená z dat a interpolačního 

algoritmu, který umožňuje mj. odvozovat výšky mezilehlých bodů.“ Podle Krchy 

Rastrová representace 
Výhody Nevýhody 

jednoduchá datová struktura méně kompaktní datová struktura 
jednoduchá kombinace s jinými rastrovými údaji 
(DPZ, fotogrammetrie) 

pro transformace je třeba speciálních algoritmů  

jednoduché vykonávání analytických operací přesnost závislá na velikosti buňky 
vhodnost pro modelování a simulace nevhodnost pro analýzy sítí 
jednoduchá tvorba uživatelských nadstaveb velký objem uložených údajů 

Vektorová representace 
Výhody Nevýhody 

vysoká polohová přesnost objektů komplikovanost struktury 
kompaktnost struktury nevhodnost pro souvislé povrchy 
grafický výstup je blízký klasickým mapám složitost výpočtů při analytických operací 
vhodnost pro modelování individuálních objektů výpočetní náročnost, potřeba specializovaného 

softwaru, kvalitního hardwaru 
malý objem uložených údajů časově náročné vytváření topologie 
přesné transformování souřadnicových systémů nevhodnost pro prostorové modelování  

a simulace 
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(1979 in Tuček 1998) jde o: „reprezentativní soubor bodů reliéfu terénu vybraných 

podle určitých pravidel, polohově lokalizovaných a přiřazeným vektorem (sloupcem 

hodnot) parametrů reliéfu terénu. Jde tedy o body, informace o nich a pravidla 

používání těchto informací.“ 

Digitální model povrchu 

 Digitálním modelem povrchu je prakticky digitální model reliéfu rozšířený o 

přírodní i antropogenní pokryv. Digitální model povrchu bývá výsledkem 

automatizovaných metod vyhodnocování výšek fotogrammetrie. Používá se 

v případě modelování krajiny, modelování měst, při vizualizacích, analýzách 

viditelností apod. (slovník VÚGT 2013). 

Digitální výškový model 

 Digitální výškový model je model reliéfu pracující výhradně s nadmořskými 

výškami bodů (slovník VÚGT 2013). Velmi často je chápán jako rastr (čtvercová 

síť) s pravidelnou hustotou bodů. 

5.2.1 Zdroje  dat 

 Data pro terénní model můžeme získat několika způsoby: pozemním 

měřením, dálkovým průzkumem nebo digitalizací již stávajících dat (nejčastěji 

vektorizací výškopisu). Při volbě vhodné metody je nutné zohlednit různá kritéria 

např. velikost území, požadovaná přesnost, časová a finanční náročnost.  

 V pozemním měření se nejčastěji používají dvě metody. První z nich je 

tachymetrie (kap. 4.2). Tento způsob nejpřesněji zachycuje průběh terénu. 

Nevýhodou je časová náročnost měření. Používá se pro menší území, kde je 

požadavek vysoké přesnosti a kvality jako např. pro přesný model terénu velkého 

měřítka, technická díla nebo pro projekční účely. Druhá metoda je využití GNSS. 

Výhodou této metody je rychlost (měřič nepotřebuje pomocníka) a přesnost. 

Nevýhodou jsou vysoké náklady na pořízení přijímače a omezené podmínky měření 

např. v lese, neboť příjem signálu GNSS vyžaduje část nezakrytého obzoru. Měření 

podrobných bodů pro tvorbu modelu terénu pomocí GPS/GNSS můžeme metodou 

diferenční GPS (angl. Differential GPS – DGPS) nebo metodou RTK (angl. Real 

Time Kinematics). Metoda diferenční GPS funguje na principu oprav měření 
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v terénu. DGPS obsahuje síť stanic, které provádějí měření 24 hodin denně a jsou 

známy její souřadnice. Referenční stanice spočítá korekce a ty jsou odeslány GPS 

přijímači v terénu. Síť referenčních stanic v ČR se nazývá CZEPOS. Metoda RTK je 

podobná DGPS, ale klade vyšší nároky na technické vybavení, neboť mezi 

referenčním a pohyblivým přijímačem musí být vybudován stálý komunikační kanál 

(Rapant 2002b) 

 Dálkový průzkum zastupují fotogrammetrické metody, radarové snímání a 

laserové skenování. Fotogrammetrie je poměrně přesná, levná a rychlá metoda. Pro 

tvorbu DMT se nejčastěji využívá letecké stereofotogrammetrie. Ke zpracování jsou 

zapotřebí vždy dva snímky, které byly pořízeny každý jiného místa, ale zobrazují 

stejné území s určitým přeryvem. Následné zpracování snímků vychází z praktického 

využití stereoskopického vjemu, který umožňuje lidskému zraku prostorové vnímání 

okolní reality (Janec, Fořt 2004). Druhou metodou dálkového průzkum je radarové 

snímání. Radarové systémy mohou kromě obrazových dat poskytovat navíc další 

specifické informace. Při radarovém snímání může být použito radarové 

interferometrie (InSAR) nebo altimetrie. Interferometrií je získáno radarové echo 

stejného místa z různých poloh. Z rozdílů fází radarových signálů se získá 

interferogram a relativní výškové rozdíly jednotlivých prvků se převedou na 

nadmořské výšky. Na podkladě interferometrického měření byl zpracován projekt 

SRTM (angl. Shuttle Radar Topography Mission), jenž poskytl digitální výškový 

model celého zemského povrchu s přesností do 16 m (Li, Zhu, Gold 2000).  

Radarová altimetrie využívá zaznamenání radarového echa jako časový interval mezi 

vysláním a přijetím signálu a jako signál modifikovaný povrchem (Klimánek 2006). 

Jelikož se mikrovlnné záření šíří konstantní rychlostí, může se spočítat vzdálenost a 

společně s dalšími parametry přepočte na absolutní výšku. Laserové skenování – 

LIDAR (ang. Light Detection and Ranging) se používá od 70. let minulého století, 

ale dnes se stává stále progresivnější metodou pro mapování. Základním principem 

je dálkoměrné měření pomocí laserového svazku paprsků, přičemž je nutné znát 

přesnou polohu skeneru a směr vysílání paprsku. Laserový paprsek se postupně 

odráží od jednotlivých vrstev objektů na zemském povrchu. Díky tomu lze např. při 
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mapování lesních porostů získat jak odraz od svrchní části koruny, tak od 

jednotlivých pater a samozřejmě od samotného zemského povrchu.  

 Posledním způsobem, jak získat výškopisná data pro vytvoření modelu terénu 

je digitalizace analogických map. Je doporučeno zvektorizovat nejen vrstevnice, ale i 

tzv. povinné hrany, jako jsou hrany a paty svahů, strže, hřbetnice, údolnice, okraje 

silnic atd. Digitalizaci je možné provádět manuálně, s různým stupněm automatizace 

nebo plně automaticky. Je to relativně levná metoda, avšak nedosahuje tak vysoké 

přesnosti.   

5.2.2 Datová representace modelů 

 Tuček (1998) rozděluje digitální modely terénu podle typu ploch, ze kterých 

jsou tvořeny: 

• rastrové modely – využívají dělení plochy na pravidelné, stejně velké plošky 

• polyedrické modely – využívají dělení plochy na nepravidelné, různě velké 

plošky, obvykle trojúhelníkového tvaru, na dílčích plochách se používá 

lineární interpolace 

• plátové modely – využívají dělení plochy na nepravidelné, různě velké 

plošky, obvykle trojúhelníkového tvaru, na dílčích plochách se používá 

nelineární interpolace, zohledňuje se průběh plochy na sousedních plátech. 

Rastrové modely terénu 

 Jak název napovídá, model je dán množinou elementárních plošek nad prvky 

pravidelného rastru. Vypovídající schopnost modelu silně závisí na jeho rozlišovací 

úrovni, na kolik jsou jednotlivé prvky rastru přimknuty ke skutečnému reliéfu terénu 

(Šindelář 1999).  Každá buňka nese hodnotu nadmořské výšky vztaženou ke středu 

buňky (grid) nebo k uzlu mřížky (lattice) vytvořené buňkami (Voženílek 2001). Mají 

všechny výhody rastrových datových representací, tedy zvláště jednoduchost a 

lehkou pochopitelnost struktury. Stejně tak jednoduchost postupů při následném 

zpracování pro výpočty odvozených parametrů a pro potřeby zobrazení (Tuček 

1998). Rastrový digitální model terénu je vhodný pro modelování relativně plochého 

reliéfu bez náhlých výškových změn (Rapant 2006). 
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Nepravidelné trojúhelníkové sítě 

 Nepravidelná trojúhelníková síť TIN (angl. Triangular Irregular Network) je 

topologická struktura reprezentující reliéf terénu (Rapant 2006). TIN využívá 

rozdělení terénní plochy na dílčí plochy, nejčastěji trojúhelníkového tvaru. Vlastní 

proces vytvoření sítě se nazývá triangulace (Břehovský, Jedlička 2006), ta je určena 

nejčastěji Delaunayho podmínkou tj. vnitřek kruhu opsaného libovolnému 

z trojúhelníků sítě neobsahuje žádný další bod sítě a velikost všech úhlů 

v trojúhelníku je maximální (Klimánek 2006). Výhodou těchto modelů v porovnání 

s rastrovými modely je zmenšený objem uložených údajů a možnost odvodit, 

vypočítat hodnotu výšky terénu (hodnota funkce Z) pro libovolný bod zkoumané 

plochy. Jsou tedy přesnější a vhodnější pro práci s liniovými objekty. Nevýhodou je 

naopak složitost struktury a postupu jejího vzniku. Stejně tak odvození jakékoliv 

informace je mimořádně výpočetně náročné (Tuček 1998). 

5.2.3 Digitální modely terénu v České republice 

 V České republice existuje několik digitální modelů terénu. Na vytváření a 

správě těchto modelů se podílí: 

• státní sektor: Český úřad zeměměřický a katastrální 

• vojenský sektor: Vojenský geografický a hydrometeorologický úřad 

v Dobrušce  

• soukromý sektor: např. ArcData Praha, Geodis Brno 

Níže jsou popsány pouze modely, které byly použity v diplomové práci. 

• ZABAGED®   

 Základní báze geografických dat České republiky – ZABAGED® je digitální 

geografický model území ČR na úrovni podrobnosti Základní mapy ČR 1:10 000 

(ZM 10). Polohopis tvoří v současné době 123 typů geografických sídel, komunikací, 

vodstva apod. Výškopis tvoří 3 typy objektů vrstevnic se základním intervalem 5, 2, 

nebo 1 m v závislosti na charakteru terénu. ZABAGED® - výškopis – 3D vrstevnice 

je doplněn vybranými dalšími výškopisnými prvky, které byly vyhodnoceny 

stereofotogrammetrickou metodou při zpřesňování vrstevnicového výškopisu. 
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Výškopisnou část ZABAGED® dále doplňuje odvozený digitální model terénu v 

podobě pravidelné mříže (10x10 m) trojrozměrně vedených (3D) bodů. Výdejní 

jednotkou je mapový list ZM 10 (18 km2) ve formátu *DGN7, *DXF nebo *SHP pro 

polohopis, a *TXT nebo *SHP pro výškopis 3D bodů. Podporovanými 

souřadnicovými systémy jsou S-JTSK / Krovak EN, WGS 84 a WGS 84 / UTM zone 

33N (ČÚZK 2013). 

• DMR 4G  

 Digitální model reliéfu České republiky 4. generace – DMR 4G představuje 

zobrazení přirozeného nebo lidskou činností upraveného zemského povrchu v 

digitálním tvaru v pravidelné síti (5x5 m) bodů o souřadnicích X, Y, H, kde H je 

výška v referenčním systému Balt po vyrovnání (Bpv) s úplnou střední chybou výšky 

0,3 m v odkrytém terénu a 1 m v zalesněném terénu. Výdejní jednotkou je mapový 

list SM 5 (5 km2) ve formátu *TXT, v souřadnicovém systému S-JTSK / Krovak EN. 

Tvorba tohoto modelu byla zahájena na pásmu “Střed”v roce 2009. V současnosti je 

vytvořen DMR 4G z pásma „Střed“ a „Západ“, tj. 67,9 % území ČR, tj. 53 529 km2. 

Předpokládané pokrytí celého území ČR je v roce 2013 (ČÚZK 2013). 
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6 Použitý software 

6.1 Leica Geo Office 

 Leica Geo Office (LGO) je vysoce automatizovaný set programů, který 

zpracovává všechny typy GPS, TPS a nivelačních dat pořízené všemi způsoby 

měření. Systém umožňuje importovat RTK měření a kombinovat je s daty pro 

následné zpracování (post-processing). Výsledky zpracování měření jsou 

zviditelněny v systému WGS84 i v lokálních systémech definovaných uživatelem a 

mohou být exportovány do systémů GIS a CAD. LGO obsahuje velké množství 

podpůrných programů, funkcí a knihoven potřebných pro produktivní práci s 

technologií Leica Systému 1200. Jsou to seznamy kódů a atributů, kartografická 

zobrazení, nástroje pro generaci elipsoidů a modelů geoidů, ukládání dat na a čtení 

dat ze senzorů. Uživatelé mohou také tvořit vlastní vstupní a výstupní formáty 

(GEFOS 2013). 

6.2 GROMA 

 Program GROMA je určen ke geodetickým výpočtům. Lze v něm řešit 

všechny základní geodetické úlohy. Navíc obsahuje jednoduchou grafiku a možnost 

digitalizace rastrových dat. Měření lze přímo importovat z formátů všech běžných 

záznamníků. Po otevření jsou všechny naměřené hodnoty zobrazeny v datovém 

okně, z něhož lze myší přetahovat do výpočetních dialogových oken. Program 

obsahuje např. tyto úlohy: polární metoda, ortogonální metoda, volné stanovisko 

(protínání zpět), protínání ze směrů, protínání z délek, polygonové pořady (i 

s výškopisným výpočtem), transformace souřadnic atd. Při všech výpočtech vznikají 

automaticky textové protokoly o výpočtu. Pro výpočty je možné sestavit libovolný 

počet sad tolerancí, jejichž překročení program automaticky testuje, a v případě 

potřeby zobrazí varovné hlášení. Program GROMA umožňuje kompletní zpracování 

zápisníku. Navíc lze měření opravit o vliv refrakce a zakřivení, o vliv indexové 

chyby, a lze dávkově spočítat převýšení zenitových úhlů. Dále umožňuje přímou 

komunikaci se systémem MicroStation a PowerDraft a digitalizaci naskenované 

mapy ve formátu *BMP (GROMA 2013). 
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6.3 MicroStation 

 MicroStation je základem řešení společnosti Bentley pro architekturu, 

stavební inženýrství, dopravu, zpracovatelský průmysl, výrobní zařízení, státní 

správu a samosprávu a inženýrské a telekomunikační sítě.  Uživatelům umožňuje 

MicroStation vytvářet 3D modely objektů a budov. Tyto modely a jejich jednotlivé 

části jsou elektronickou simulací reálných objektů a obsahují všechny informace 

o jejich parametrech.  

 Základní „slovník“, se kterým MicroStation pracuje, je definován jeho 

vlastním formátem známým jako *DGN. Tento formát neobsahuje žádná omezení 

přesnosti, počtu vrstev či velikosti výkresu nebo buněk. MicroStation V8 ovšem 

není pevně spojen s formátem *DGN, ale dokáže otevřít a uložit i soubory jiných 

formátů. Jednou z výhod technologie uvnitř MicroStationu V8, která pro podporu 

různých formátů využívá princip slovníků, je možnost přímo pracovat s *DWG 

výkresy vytvořené programem AutoCAD. Díky této schopnosti je MicroStation V8 

jediným dostupným nástrojem, který dokáže pracovat s oběma nejpopulárnějšími 

CAD formáty. *DWG data zpracovává MicroStation V8 na stejné úrovni jako 

samotný AutoCAD, a to včetně grafických elementů, hladin, pohledů a rozvržení. 

Samotný MicroStation V8 může interpretovat větší rozsah informací, než jaké jsou 

obsaženy v *DWG a *DGN souborech, takže oba formáty mohou být při práci 

formou referenčních výkresů libovolně kombinovány. V prostředí, kde se používá 

AutoCAD i MicroStation, využívá MicroStation V8 tzv. *DWG pracovní režim, 

ve kterém jsou funkce MicroStationu využívány tak, aby byla zachována maximální 

kompatibilita s *DWG formátem (Šíma 2008). 

6.4 ArcGIS 

 Systém ArcGIS firmy ESRI tvoří řada škálovatelných produktů určených pro 

kompletní nasazení GIS na jakékoli úrovni. Součástí ArcGIS jsou desktopové, 

serverové i vývojářské produkty, nechybí ani řešení pro mobilní zařízení a 

specializované nadstavby (ArcData 2013). ArcGIS má tři úrovně: 

• ArcView  – umožňuje prohlížet, organizovat a dokumentovat data.Je 

nejzákladnějším a nejjednodušším modulem ArcGIS. 
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• ArcEditor  – má všechny funkce jako ArcView a navíc nástroje pro editaci 

shapefilů a geodatabází. 

• ArcInfo  – je nejvyšší verzí GIS software od firmy ESRI. Obsahuje všechny 

funkce výše zmíněných komponent a obsahuje řadu dalších pokročilých 

nástrojů pro práci s geodety (Pixová 2007, ESRI 2013). 

 Do kategorie ArcGIS for Desktop spadají produkty ArcGIS for Desktop 

Basic, ArcGIS for Desktop Standard, ArcGIS for Desktop Advanced a volně 

dostupný prohlížeč publikovaných map ArcReader. Každý z těchto produktů 

poskytuje různou úroveň funkcionality, podle potřeby uživatele (ArcData 2013). 

ArcGIS for Desktop obsahuje řadu vzájemně propojených aplikací: 

• ArcCatalog – organizuje a uspořádává data používaná v GIS. Tuto aplikaci lze 

přirovnat např. k programu Průzkumník nebo Total Commander, které se 

používají pro běžné nakládání se soubory v počítači. Umožňuje náhledy těchto 

dat před jejich otevřením. 

• ArcMap  – používá se k prohlížení a editaci geografických dat. Umožňuje 

vytváření profesionální map, grafů, projektů a zpráv. Při vytváření map se může 

práce uložit jako mapový dokument, soubor s koncovkou *MXD. 

• ArcToolbox – je aplikací umožňující vykonávat GIS analýzy na pokročilejší 

úrovni. Jedná se o soubor nástrojů pro vytváření, propojování, exportování a 

importování dat různých formátů (Pixová 2007). 

 

 

 

 

 

 

 

 



 

 
 

35

7 Metodika 

7.1 Zaměření v terénu  

 Před vlastním měřením bylo nutné provést rekognoskaci terénu. Jelikož 

veškeré měření se mělo provádět v lesním porostu, bylo zapotřebí rozvrhnout si 

dobře měřickou síť a vytyčit v terénu body, které měly posloužit jako orientace. 

Právě vhodnému umístění bodů (orientací) bylo nezbytné věnovat velkou pozornost 

z důvodu jejich zaměření pomocí GNSS. 

a) Tachymetrie 

Použité měřické pomůcky: 

• totální stanice Topcon GTS 105-N 

• stativ 

• 2 odrazné hranoly s výtyčkami 

• 2 stojánky 

• metr 

 Tachymetrické měření bylo provedeno z pomocných bodů měřické sítě, které 

byly v terénu dočasně stabilizovány dřevěným kolíkem. Na každém stanovisku byla 

provedena centrace, horizontce a změřena výška stroje. Směry a délky orientací byly 

měřeny v 1. i 2. poloze dalekohledu, podrobné body (stezka a okolní terén) byly 

měřeny pouze v 1. poloze. Jelikož stezka má tvar otevřeného koryta – lichoběžníka, 

byla zaměřena jak její horní, tak i spodní hrana.  

 Topcon GTS 105-N (v.č. 6H1200) 

Technické parametry 

• přesnost úhlů: 5´´ (1,5 mgon) 

• rozsah kompenzace: 7´ 

• přesnost měření vzdáleností: ± 2 mm + 2ppm 

• délkové měření: 900 m (minihranol), až 4000 m (9 hranolů) 

• dalekohled: zvětšení 30x, min. zaostřovací vzdálenost 1,3 m 

• oboustranný LCD displej 

Totální stanice Topcon GTS 105-N má rozsáhlou paměť až na 24 000 měřených 

bodů ve 30 zakázkách. Má velké množství aplikačních programů a je vysoce odolný 

proti nepříznivým podmínkám prostředí. 
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b) Zaměření orientací pomocí GNSS 

Použité měřické pomůcky: 

• Leica GPS 1200  

• výtyčka + ostatní příslušenství  

 Měření bylo provedeno rychlou statickou metodou (kap. 4.3.1). Toto měření 

je velice často používané v geodézii pro svou rychlost, neboť doba observace na 

bodě je poměrně krátká. Každý bod orientace byl zaměřen dvakrát. Doba mezi 

prvním a druhým měřením byla delší než jedna hodina. 

 Leica GPS 1200 (i.č. SMV 09608671) 

Technické parametry: 

• třífrekvenční anténa: ATX 1230 GNSS 

• příjem: 120 kanálů 

• frekvence: L1/L2/L5 GPS; L1/L2 GLONASS; E1/E5a/E5b/Alt-BOC Galileo 

• přesnost RTK – statická (podle ISO17123-8): 

 5 mm + 0,5 ppm (horizontálně); 10 mm + 0,5 ppm (vertikálně) 

• bluetooth port 

• software: RX 1250Xc Windows CE kontroler 

• MCF 256 paměťová karta Compact Flash 256 MB 

Leica GPS 1200 umožňuje měření prakticky všemi způsoby: statickou metodou, 

rychlou statickou metodou, metodou „stop and go“, kinematickou metodou, RTK – 

Real Time Kinematics nebo diferenční GPS (DGPS). Dále má velké množství 

aplikací: měření bodů, vytyčování, transformace souřadnice aj. 

7.2 Zpracování výsledků  

Výpočet orientací  

 Orientace byly spočítány v programu Leica Geo Office (LGO) za pomoci  

Ing. Vlasáka. 

 V programu LGO byl vytvořen nový projekt, do kterého byla nahrána 

naměřená data ze systému Leica GPS 1200. Výpočet souřadnic bodů změřených 

pomocí GNSS má dva kroky – výpočet vektorů a transformace souřadnic do 

lokálního sytému. 
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a) výpočet vektorů  

 Jedná se o výpočet přesného relativního vztahu mezi referenční stanicí a 

rovery. Pokud v terénu není k dispozici spojení s referenční stanicí, je nutné stáhnout 

data z referenční stanice a provést výpočet vektorů v programu LGO. Dále je potřeba 

nastavit parametry výpočtu: výšková maska (minimální úhlová výška družic nad 

horizontem), parametry drah družic (vysílané; přesné), GNSS typ (GPS; 

GLONASS), aktivní satelity, frekvence aj. 

b) transformace souřadnic do lokálního systému 

 Pro transformace v LGO je zapotřebí dvou projektů: Projekt A obsahující 

vstupní WGS84-ETRS89 souřadnice a projekt B obsahující vstupní souřadnice S-

JTSK identických bodů. Poté následuje výpočet transformačního klíče podle předem 

vybrané transformace. V tomto případě byla vybrána tzv. „Klasická 3D“  

transformace, kdy souřadnice z obou projektů jsou nejdříve pomocí zobrazovacích 

rovnic přepočteny na geocentrické kartézské souřadnice. Na úrovni geocentrických 

kartézských souřadnic probíhá výpočet 3D Helmertovy transformace, jejímž 

výsledkem je 7 prvků: 3 posuny, 3 rotace a měřítkový faktor. Tato transformace 

vyhovuje pro všechny případy, kdy u identických bodů známe polohu i výšku v 

rovnocenné přesnosti (Leica Geo Office 2007).  

Výpočet polygonového pořadu a podrobných bodů 

 K těmto výpočtům byl použit geodetický program GROMA v. 8.0. Nejprve 

byl vytvořen nový soubor souřadnic: Seznam souřadnic, do kterého byly uloženy 

souřadnice bodů – orientací vypočtené v programu Leica Geo Office. Poté byl 

založen nový seznam měření: Seznam měření – polární data. Do toho seznamu byly 

naimportovány naměřené hodnoty z totální stanice Topcon GTS-105 N. Před 

výpočtem oboustranně připojeného a orientovaného polygonového pořadu, bylo 

zapotřebí spočítat počáteční bod – 5001 a koncový bod – 5032 polygonového 

pořadu. K tomu nám posloužila funkce Volné stanovisko, protokol o výpočtu volného 

stanoviska. Poté již bylo možné spočítat polygonový pořad funkcí – Polygonový 

pořad dávkou. Tento pořad byl spočítán polohově i výškově, protokol o výpočtu. 

Následoval výpočet souřadnic podrobných bodů – Polární metoda dávkou. Protokol 

o výpočtu polární metody dávkou. 
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Zpracování v programu MicroStation V8 

 Nejprve byl vytvořen nový výkres zlata_stezka.dgn ve formátu seed3d.dgn, 

který zaručuje 3D zobrazení bodů a pracuje s nadmořskou výškou (souřadnice Z). Do 

programu MicroStation byly naimportovány všechny body včetně bodů 

polygonového pořadu a jeho orientací a to díky propojení programu GROMA a 

MicroStation. K tomuto propojení posloužil příkaz mdll load groma. Následně byly 

tyto body spojeny tak, aby odpovídaly skutečnosti – profilu Zlaté stezky. Tento 

mezikrok, import bodů a jejich následné spojení v programu MicroStation, se ukázal 

jako vhodný způsob získání nadmořské výšky jak bodů, tak i samotných linií. 

Nadmořská výška se totiž automaticky přiřadí jako třetí souřadnice Z k souřadnicím 

X a Y vyjadřující polohu. Této vlastnosti bude dále využito v programu ArcGIS.  

7.3 Zpracování v ArcGIS 

 V programu ArcGIS byl založen nový pracovní dokument: Zlata_stezka.mxd 

(File > Save). V tomto dokumentu byl nastaven souřadnicový systém pro Českou 

republiku: S-JTSK Krovak EastNorth (Layers > Properties > Coordinate System > 

Projected Coordinate Systems > National Grids). Poté byl připojen výkres se 

zaměřenými body a liniemi představující průběh Zlaté stezky ve formátu *DGN: 

zlata_stezka.dgn (Add Data). S formátem *DGN však nedokáže program ArcGIS 

pracovat, proto bylo zapotřebí převést body a linie na vhodný formát *SHP: (Data > 

Export Data). Vznikla tak nová bodová (point) 3D vrstva  stezka_body.shp a liniová 

(polyline) 3D vrstva stezka_linie.shp. Na první pohled se 3D vrstva nikterak neliší od 

2D, avšak po otevření atributové tabulky: Open Attribute Table lze vidět u 3D 

sloupec Shape, ve kterém je Point ZM (bodová vrstva) nebo Polyline ZM (liniová 

vrstva). V tomto sloupci jsou uloženy souřadnice X, Y a Z, které jsou pro uživatele 

skryty, ale je možné, kdykoliv je zobrazit pomocí skriptu ve Field Calculator (Open 

Attribute Table > Options). Při převodu *DGN na *SHP se souřadnice Z zobrazí 

navíc ve sloupci Elevation . Dále jsou v atributové tabulce zobrazeny i další sloupce, 

které informují např. o předchozím formátu *DGN nebo o názvu vrstvy, ve které 

byly zobrazeny body či linie v programu MicroStation. Tyto přebytečné sloupce byly 

odstraněny pomocí funkce: Delete Field (Open Attribute Table > Options). V tomto 

okamžiku byla připravena naměřená data pro tvorbu digitálního modelu terénu. 
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7.3.1 TIN 

 Model TIN pracuje na bázi nepravidelné trojúhelníkové sítě (kap. 5.2.2). Při 

tvorbě TIN je možné použít vektorové vrstvy všech základních geometrických typů: 

body, linie a polygony. U každého typu je nutné určit, co představuje (typ vstupu): 

• Mass points – představují body se známou nadmořskou výškou a tvoří 

vrcholy budoucího TIN.   

• Breaklines – jsou čáry označující místa se zřetelnou změnou průběhu terénu 

(singularity). Používají se např. k vyznačení řek, pat budov, údolnic, průběhu 

valu či navigace. Bez těchto údajů je zpravidla model nepřesný. Též lze říci, 

že linie zadané jako Breaklines se ve výsledku uplatňují jako povinné hranice 

trojúhelníků, tj. neprobíhá přes ně interpolace a ponechávají si svou původní 

hodnotu. 

• Clip polygons – ohraničují řešené území, tj. ohraničují interpolaci a definují 

prostorový rozsah výsledného TIN. 

• Erase polygons – ohraničují území, které bude z výsledku vymazáno. 

• Replace polygons – se používají pro definici plochých (vodorovných) území. 

• Tag value fill polygons – přiřazují trojúhelníkům uvnitř polygonů 

celočíselný atribut (např. kód představující typ krajinného pokryvu. Tento 

atribut může být použit při vizualizaci modelu (výsledné zobrazení pak 

evokuje terén potažený další vrstvou). 

 Každý z vyjmenovaných typů vstupů kromě Mass points může být definován 

jako Soft (měkký) nebo Hard (tvrdý) – např. Breaklines ve skutečnosti zadáváme 

jako Softlines nebo Hardlines. Linie nebo hranice polygonů definované jako Hard 

představují zřetelné zlomy terénu (např. náspy, hráze, údolnice). Soft hranice 

nenarušují hladký průběh terénu a nemají geomorfologický význam. Při jejich 

použití se na jejich místě vytvoří hranice trojúhelníků, které však nepředstavují 

terénní změny. Příkladem Soft hranic mohou být třeba hranice okresů či jiných částí 

zájmového území (Šímová 2008). 

 Tvorba modelu TIN v programu ArcGIS má dva kroky: vytvoření prázdného 

modelu a jeho následná editace. Prázdný TIN se vytvoří: Create TIN (3D Analyst  
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Tools > TIN Creation) a jako referenční systém se nastaví S-JTSK Krovak 

EastNorth. Funkcí Edit TIN (3D Analyst Tools > TIN Creation) se spustí editace a 

prakticky tvorba celého modelu. Zde je nutné nastavit správně vstupní hodnoty (typ 

vstupu) a sloupec s nadmořskou výškou. Bodové vrstvě stezka_body.shp byl přiřazen 

typ Mass points a liniové vrstvě stezka_linie.shp typ Breaklines – Hardlines. 

Nadmořskou výšku bylo možné načíst ze sloupce Shape nebo Elevation. Vzniklý 

model byl pro přehlednost „oříznut“ podle předem definovaného polygonu funkcí: 

Clip polygons v editaci TIN, rozdělen na tři části a vyexportován (File > Print). 

Z modelu TIN lze velmi snadno získat vrstevnice a to funkcí TIN Contour (3D 

Analyst Tools > TIN Surface). Interval vrstevnic byl nastaven na 1 m. Vrstevnice 

však bylo nutné před výstupem „vyhladit“. K tomu posloužila funkce: Smooth Line 

(Data Managment Tools > Generalization). Ta nabízí dvě možnosti interpolace: 

Peak – vyhlazené vrstevnice neprochází vstupními body a Bezier Interpolation – 

vrstevnice vstupními body prochází. Pro vyhlazení vrstevnic byla nakonec použita 

metoda Peak s tolerancí 5. Takto upravené vrstevnice byly opět rozděleny na tři části 

a vyexportovány ve formě vrstevnicového plánu. 

7.3.2 Rastrový model 

 Rastrový model byl vytvořen z původního modelu TIN a to interpolační 

metodou Natural Neighbours (přirozených sousedů). Tato metoda je založena na 

principu Thiessenovych polygonů. Polygony jsou vytvořeny z bodové vrstvy tak, že 

do každého polygonu spadá jeden bod a všechna místa polygonu jsou blíže bodu, 

který leží uvnitř něho, než bodu jinému. Tato metoda je velice efektivní, pokud jsou 

naměřené hodnoty rozmístěny pravidelně. Metoda spočívá v odhadu neznámých 

hodnot z několika nejbližších hodnot. Území je nejprve rozděleno do nepravidelných 

trojúhelníků (tzv. Delaunay triangulace), z nichž jsou následně vytvořeny tzv. 

Thiessenovy polygony (Burian 2008). 

 Pro převod TIN na rastrový model slouží funkce: TIN to Raster (3D Analyst 

Tools > Conversion > From TIN). Zde byla nastavena již zmíněná metoda Natural 

Neighbours a velikost buňky (Cell size) na hodnotu 0,25. Pro realistické znázornění 

vlastního terénu v rastrovém modelu slouží funkce osvit: HillShade (3D Analyst  

 



 

 
 

41

Tools > Raster Surface). Zde se nastavují dva parametry: Azimuth – natočení ke 

světové straně ve stupních a Altitude – výška nad obzorem. V tomto případě byl 

Azimuth nastaven na 315° a Altitude na 50°.  Vznikl tak nový rastrový model, jehož 

výstup byl pro přehlednost rozdělen na 3 části. 

7.3.3 Porovnání přesnosti 

 Při zaměřování úseku Zlaté stezky byl zaměřen i okolní terén (kap. 7.1), ale 

pro vizualizaci většího modelu TIN a rastrového modelu se toto měření ukázalo jako 

nedostatečné. Pro další presentaci výsledků, bylo vhodné propojit zaměřený úsek 

s výškopisnými daty ZABAGED® nebo s digitálním modelem reliéfu DMR 4G. 

Předtím, však bylo zapotřebí zjistit, jaké odchylky jsou mezi skutečnými 

(naměřenými) nadmořskými výškami a daty ZABAGED® resp. DMR 4G. 

 Pro porovnání nadmořských výšek bylo předem nutné upravit vstupní data. 

Z naměřených hodnot byly odstraněny body, které představují „dno“ stezky. Vznikla 

tak nová bodová vrstva: vysky.shp, která representuje pouze horní hranu stezky a 

okolní zaměřený terén. Dále byla vytvořena nová polygonová vrstva 

polygon_vyska.shp, zahrnující pouze okolní terén a to nejen podél stezky a mezi 

jednotlivými kolejemi stezky, ale i zaměřený terén před začátkem a po ukončení 

průběhu stezky samotné.  

 Pro porovnání nadmořských výšek byly použity 2 metody. První je vizuální – 

na základě rozdílů dvou rastrových modelů. Tato metoda zobrazí místa s rozdílnou 

nadmořskou výškou a přibližnou hodnotu jejich rozdílu. Druhá metoda je porovnání 

nadmořských výšek konkrétních bodů s hodnotami vzniklého modelu. Z rozdílů lze 

vytvořit graf četnosti a dále pak stanovit střední kvadratickou chybu (Root Mean 

Square Error – RMSE) podle vzorce: 

 

 

kde ∆h je rozdíl skutečné naměřené výšky a výšky ve stejném místě modelu a N je 

počet kontrolních bodů. 
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Pro lepší názornost je zde uveden postup provedených prací. 

 

Porovnání naměřených hodnot a ZABAGED® 

 Nejprve byl vytvořen rastrový model terénu z výškopisných dat ZABAGED® 

– vrstevnic o intervalu 5 m. Pro tvorbu rastrového modelu byla použita metoda Topo 

To Raster. Tato speciální interpolační metoda je navržená pro tvorbu hydrologicky 

správných modelů terénu. Zakládá se na programu ANUDEM (Kienzle 2004) a je 

upravením metody Spline (Burian 2008). Ke vzniku modelu se využívá vrstevnic 

(Contour). Do výpočtu lze doplňkově zařadit i výškové body, např. vrcholy kopců 

(PointElevation) a řadu singularit: 

• Sream – Hydrografická síť. Může výrazně zlepšit kvalitu modelu. Průběh 

Stream má ve výpočtu prioritu před vrstevnicemi. 

• Lake – Vodní plochy, obecně zcela plochá místa v modelu. Buňky v lokalitě 

vodní plochy dostanou hodnotu minima pobřežní čáry (okraje). 

• Sink – Známé terénní deprese, skutečné bezodtokové oblasti. V depresi musí 

být známá výška, která se udává jako parametr Field. Hodnota se zahrne do 

výpočtu, čímž se model zpřesní. Příkladem mohou být třeba závrty na 

krasové planině. 
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• Boundary – Hranice výstupu. Všechny buňky výstupního rastru, které se 

ocitnou mimo polygon představující hranici, budou NoData. Tj. můžeme 

výstup přímo nastavením výpočtu oříznout podle hranic nějaké zájmové 

lokality (Šímová 2008). 

 Rastrový model terénu vznikl funkcí Topo To Raster (3D Analyst Tools > 

Raster Interpolation), kdy vstupem byly vrstevnice ZABAGED® jako typ Contour a 

předem vytvořený polygon zajmove_uzemi.shp jako typ Boundary. Tento polygon 

zahrnoval nejbližší okolí všech zaměřených bodů a fungoval jako hranice výstupu. 

Digitální model se tak netvořil ze všech vrstevnic, ale pouze z vrstevnic uvnitř 

polygonu. Velikost buňky rastru (Cell size) byla nastavena na 0,25. 

 S pomocí funkce Extract by Mask (Spatial Analyst Tools > Extraction) byl 

postupně „vyříznut“ pro kontrolu přesnosti vyska_polygon.shp z rastrového modelu 

(vytvořeného z TIN) a z rastrového modelu (ZABAGED®). Následně byly tyto dva 

rastry od sebe odečteny funkcí: Minus (3D Analyst Tools > Raster Math). 

 Pro druhou metodu kontroly přesnosti nadmořských výšek byl využit nově 

vytvořený rastrový model terénu z vrstevnic ZABAGED® a naměřených bodů 

vysky.shp. Funkcí: Interpolate Shape (3D Analyst Tools > Functional Surface) byly 

vyexportovány body z rastru, které jsou identické s naměřenými body vysky.shp. 

Vznikla tak nová bodová vrstva TIN_ZABAGED.shp. V atributové tabulce byla 

zobrazena nadmořská výška měřených bodů (sloupec Elevation). Nadmořská výška 

ZABAGED® byla skryta ve sloupci Shape (kap. 8.3). Pro její zobrazení bylo 

zapotřebí vytvořit nový sloupec Add Field a pomocí skriptu ve Field Calculator 

vyexportovat:    Dim Output As Double 

    Dim pPoint As IPoint 

    Set pPoint = [Shape] 

    Output = pPoint.Z 

kde pPoint.Z představuje nadmořskou výšku (souřadnici Z). Analogicky lze takto 

vyexportovat i souřadnice X a Y. Poté byl opět vytvořen nový sloupec Add Field a 

v něm ve Field Calculator došlo k odečtení výšky naměřené a nadmořské výšky 

ZABAGED®. Výhodou funkce Fiel Calculator je ta, že výpočet je proveden pro  
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celý sloupec popř. pouze pro označená data. Z vypočtených rozdílů byl vytvořen graf 

četnosti a spočítána střední kvadratická chyba RMSE. 

 

Obr. 7.1 Graf četnosti rozdílů nadmořských výšek - ZABAGED 

min. = - 4,32 m max. = 3,52 m průměr = 0,35 m RMSE = 1,42 m 

Porovnání naměřených hodnot a DMR 4G 

 Rastrový model terénu byl vytvořen interpolací Natural Neighbours (3D 

Analyst Tools > Raster Interpolation) o velikosti buňky (Cell size) 0,25. Celý postup 

byl prakticky stejný jako u rastrového modelu ZABAGED®. tj. vyříznutí kontrolních 

polygonů vrstvou vyska_polygon.shp a jejich následné odečtení od měřených hodnot 

funkce: Minus (3D Analyst Tools > Raster Math).  A poté i druhý způsob kontroly 

přesnosti nadmořských výšek, kdy vznikla nová bodová vrstva TIN_DMR.shp, ve 

které byly zjištěny rozdíly nadmořských výšek a následně vytvořen graf četnosti 

těchto rozdílů společně s výpočtem střední kvadratické chyby.  
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Obr. 7.2 Graf četnosti rozdílů nadmořských výšek – DMR 4G 

min. = - 2,07 m max. = 2,02 m průměr = - 0,19 m RMSE = 0,43 m 

 

Vliv rozlišení buňky rastru na kvalitu přesnosti 

 Veškeré rastrové DMT byly vytvořeny s velikostí buňky 0,25 ve snaze o co 

největší možnou přesnost. Avšak nevýhodou vysokého rozlišení je obrovské 

množství dat, vyšší nároky na hardware a software a také delší doba zpracování 

výsledků. Proto byl dále zkoumán vliv velkosti buňky na přesnost vytvořených 

rastrových modelů za účelem nižšího objemu dat.  

 Postupně byly vytvořeny rastrové modely terénu o rozlišení: 0,25 – 0,5 – 1,0 

– 2,0 – 5,0. Pro data ZABAGED® byla opět použita funkce: Topo To Raster (3D 

Analyst Tools > Raster Interpolation) a pro DMR 4G interpolační metoda Natural 

Neighbours (3D Analyst Tools > Raster Interpolation). Nově vzniklé rastry byly 

porovnávány s bodovou vrstvou naměřených nadmořských výšek a byla pro ně 

spočítána střední kvadratická chyba. 
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Rozdíl měřených výšek a  ZABAGED 

Velikost buňky 0,25 0,5 1,0 2,0 5,0 
Velikost dat 53,96 MB 13,49 MB 3,38 MB 866,53 kB 139,90 kB 

Min [m] - 4,32 - 4,31 - 4,29 -4,29 -3,96 
Max [m] 3,52 3,53 3,54 3,63 3,53 

Průměr [m] 0,35 0,35 0,35 0,35 0,38 
RMSE [m] 1,42 1,42 1,43 1,44 1,42 

Tab. 7.1 Kontrola přesnosti – ZABAGED  

Rozdíl měřených výšek a DMR 4G 

Velikost buňky 0,25 0,5 1,0 2,0 5,0 
Velikost dat 53,48 MB 13,38 MB 3,35 MB 860,23 kB 138,36 kB 

Min [m] - 2,07 - 2,07 - 2,07 - 2,07 - 2,07 
Max [m] 2,02 2,02 2,02 2,02 2,02 

Průměr [m] - 0,19 - 0,19 - 0,19 - 0,19 - 0,19 
RMSE [m] 0,43 0,43 0,43 0,43 0,43 

 Tab. 7.2 Kontrola přesnosti – DMR 4G 

 Navzdory předpokladům o klesající kvalitě při zmenšování rozlišení rastru, 

z uvedených hodnot vyplývá, že při snižování rozlišení se kvalita rastrového modelu 

pro dané území téměř nemění. Dále je patrné, že pro tvorbu rozsáhlejšího modelu 

terénu jsou nejvhodnější data DMR 4G. 

7.3.4 Vizualizace terénu 

 Jak již bylo zmíněno, pro tvorbu většího modelu terénu zahrnující širší okolí 

zaměřeného úseku Zlaté stezky, byla vybrána výškopisná data DMR 4G. Nyní bylo 

zapotřebí vhodnou interpolační metodou propojit tato data s naměřenými hodnotami. 

Jako nejvhodnější interpolace byla vybrána geostatistická metoda Kriging, která 

provádí vypočet neznámé hodnoty pomoci váženého průměru. Váhy jsou určeny 

podle prostorové variability a poskytují tak optimální interpolaci s minimálními 

odchylkami (Desmet 1997). Kriging vytvořil Georges Matheron na základě práce 

Daniela G. Krige již v roce 1963. Kriging je výpočtově jedna z nejsložitějších a řadí 

se mezi exaktní interpolační metody. Používá se zejména pro geologické aplikace, 

někdy se však hodí také pro interpolaci výšek nebo meteorologických dat (Burian 

2008). 

 Pro tvorbu rozsáhlejšího modelu určeného k presentaci a 3D vizualizaci bylo 

zapotřebí připravit si vstupní data. Byl vytvořen polygon čtvercového tvaru o rozloze 

1,44 km2, představující hranici zájmového území. Podle tohoto polygonu byla 



 

 
 

47

oříznuta data funkcí Clip (Analysis Tools > Extract) z DMR 4G a vznikla tak nová 

bodová vrstva cuzk.shp. Dále bylo podle tohoto polygonu oříznuto orotofoto funkcí 

Extract by Mask (Spatial Analyst Tools > Extraction). Dalšími nezbytnými daty byla 

bodová vrstva stezka_body.shp, liniová vrstva stezka_line.shp. 

 Po zapnutí funkce Kriging (Geostatistical Analyst > Geostatistical Wizard), 

byla nastavena jako vstupní vrstva stezka_body.shp. Poté byl vybrán druh Kriging – 

Ordinary, který se používá, pokud se v datech nevyskytuje vliv jiného faktoru a typ 

semivariogramu Spherical. Vznikla tzv. Geostatistical Analyst Layer, jejíž hodnoty 

byly naimporotvány funkcí GA Layer To Points (Geostatitistical Analyst Tools) do 

bodové vrstvy cuzk.shp a vznikla nová vrstva body_tin.shp. Následovala tvorba 

modelu TIN novy_tin (kap. 8.3.1), kdy vstupními hodnotami byla nově vzniklá 

bodová vrstva body_tin.shp a stezka_linie.shp. Z tohoto modelu byly následně 

vyexportovány vrstevnice funkcí TIN Contour (3D Analyst Tools > TIN Surface) 

s intervalem 2 m. Tyto vrstevnice byly opět funkcí Smooth Line (Data 

ManagementTools > Generalization) metodou Peak 5 vyhlazeny do konečné podoby 

vrstevnice.shp. 

 Pro vlastní 3D vizualizace slouží nadstavba ArcScene, která svým prostředím 

připomíná ArcMap, pouze s tím rozdílem, že zde nelze vytvořit klasický layout 

(výstup). Nenachází se zde tak možnost zobrazení měřítka, připojení legendy či 

severky. Výhodou této aplikace je prostorové zobrazení předmětů z různých úhlů a 

stran. Připojený model TIN (Add Data) má automaticky přiřazenou nadmořskou 

výšku. Pro lepší vizualizaci a znázornění výškových rozdílů byla nastavena konstanta 

Custom (Properties > Base Heighst) na hodnotu 2. Dále byla připojena vrstva (Add 

Data) stezka_linie.shp, vrstevnice.shp a oříznuté ortofoto. Těmto vrstvám bylo 

potřeba společně s konstantou Custom 2 přiřadit také nadmořské výšky z modelu 

TIN (Properties > Base Heighst). Výstupem se stal 3D vrstevnicový model a 3D 

model, jehož povrch byl znázorněn orotofotem. Z těchto modelů byla následně 

vytvořena animace. 
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8 Výsledky 

 Prvním výsledkem diplomové práce je bezpochyby geodetické zaměření 

současného stavu úseku Zlaté stezky a následná tvorba přesného digitálního modelu 

terénu metodou TIN. Tento model byl vytvořen bez jakýchkoliv úprav a vyhlazení 

hran. Z modelu TIN byly následně vyexportovány vrstevnice s intervalem 1 m pro 

tvorbu vrstevnicového plánu měřeného území. 

  Poté byl model TIN převeden na rastrový model. Bylo to jednak z důvodu 

vytvoření realističtějšího zobrazení daného území pomocí funkce Hillshade (osvit) a 

z důvodu pozdější analýzy – kontroly přesnosti výškopisu. 

 Dalším výsledkem je porovnání přesnosti změřených nadmořských výšek s 

výškopisem ZABAGED® a DMR 4G. Při této analýze bylo zjištěno, že přestože 

průměrný rozdíl nadmořských výšek měřených hodnot a ZABAGED® je +0,35 m 

(+0,38 m pro velikost buňky rastru = 5), rozptyl těchto rozdílů je značně velký a 

kolísá od +3,63 m do -4,32 m. Tato chyba je způsobena méně přesným výškopisem 

ZABAGED®, neboť ten byl odvozen z map ZM10, kde vrstevnice v lesním porostu 

a na prudších svazích jsou v intervalu 5 m. Velký rozptyl rozdílů výšek a 

nepravidelné střídání jejich kladných a záporných hodnot v měřeném úseku, snížilo 

možnost dalšího využití výškopisných dat ZABAGED®. Při porovnání měřených 

výšek a DMR 4G byl zjištěn průměrný rozdíl -0,19 m (-0,18 m pro velikost buňky 

rastru = 5). Dále bylo zjištěno, že rozptyl rozdílů není závislý na velikosti buňky 

rastru a pohybuje se od +2,02 m do -2,07 m. Stejně jako u dat ZABAGED® dochází 

k nepravidelnému střídání hodnot rozdílů nadmořských výšek, ale rozptyl a střední 

kvadratická chyba byla nižší než u ZABAGED®, proto byla data DMR 4G využita 

pro tvorbu komplexnějšího modelu terénu. 

 Posledním výstupem se tak stal rozsáhlejší 3D model terénu zahrnující i širší 

okolí. Předtím bylo však nutné vzájemně propojit naměřená data s DMR 4G. Nejprve 

byly změřené body interpolovány geostatistickou metodou Kriging a poté 

importovány k DMR 4G. Z těchto společných dat byl vytvořen nový model TIN, ze 

kterého byly následně vyexportovány vrstevnice. Výsledkem se stal prostorový 3D 

model terénu zobrazený v nadstavbě ArcScene včetně animace. 
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9 Diskuse 

 Použité metody tvorby digitálního modelu terénu má mnoho výhod, ale také 

svá omezení. V této kapitole bych rád přiblížil některé z nich. 

9.1 Vstupní data 

 Geodetické zaměření v terénu je sice nejpřesnější způsob získání dat pro 

DTM, ale je velice časově a finančně náročné. Další nevýhodou je využití 

geodetického měření pouze pro menší území. Při tvorbě DMT větších celků, kterými 

se v minulosti zabývaly ve své práci Kartografická vizualizace a tvorba digitálního 

modelu terénu okolí hradu Veveří (Hašová 2009) či Kartografická 3D vizualizace 

okresu Přerov  (Střílková 2012), je získávání dat přímým měřením v terénu naprosto 

nevhodné. Pro takováto velká území je dobré využít výškopisných dat ZABAGED® 

spravovaných ČÚZK či vojenského digitálního modelu území (DMÚ 25). 

V současné době se dokončuje úplné pokrytí České republiky DMR 4. G, který má 

tvar pravidelné sítě bodů 5x5 m. V roce 2015 se předpokládá úplné pokrytí ČR 

digitálním modelem reliéfu 5. generace (DMR 5G), který má tvar nepravidelné sítě 

bodů (TIN) se střední chybou výšky 0,18 m v odkrytém terénu a 0,3 m v terénu 

zalesněném (ČÚZK 2013).  

9.2 Tvorba DMT 

 Výsledný model terénu neovlivňuje pouze kvalita vstupních výškopisných 

dat, ale také výběr vhodných interpolačních metod při tvorbě DMT. Burian (2008) ve 

svém článku popisuje možnosti využití různých typů interpolací pro konkrétní účely. 

Závislostí interpolačních metod na kvalitu DMT se zabýval např. Desmet (1997), 

který zkoumal vhodné interpolace pro malá rovinatá území v Belgii (do 3 – 4 ha), 

kde se jevila jako nejvhodnější interpolační metoda Spline. 

 V této práci bylo ověřeno, že pro tvorbu DMT z vrstevnic je nejvhodnější 

metoda Topo To Raster. Naopak pro vytvoření DMT z pravidelné sítě bodů je 

nejlepší použít interpolační metodu Natural Neighbours. Pro propojení naměřených 

dat a výškopisu DMR 4G se osvědčila geostatistická metoda Kriging. Je to velice 

přesná interpolační metoda, neboť neznámé hodnoty vypočítává podle váženého 

průměru. Nevýhodou této metody je velmi složitý výpočet. 
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9.3 Porovnání přesnosti DMT 

 Při posuzování přesnosti DMT byly porovnávány nejen zdroje dat, ale i vliv 

velikosti buňky na kvalitu výsledného rastrového DMT. Při porovnávání naměřených 

dat s daty z ČÚZK, bylo zjištěno, že nejmenší rozdíly jsou při použití DMR 4G. Jak 

bylo již řečeno, kvalita výškopisu ZABAGED® je snížena z důvodu převzatých 

vrstevnic z map ZM10 o intervalu 5 m.  

 Podobnou analýzu přesnosti provedli Janec, Fořt (2004), kteří srovnávali 

přesnost vojenského digitálního modelu reliéfu (DMR) a digitálního výškového 

modelu (DEM) vytvořeného z dat družice SPOT a jejich použitelností pro tvorbu 

ortofota, kdy zjistili, že DMR nelze vzhledem k své přesnosti výškopisu využít jako 

podklad map měřítek větších než 1:50 000, u DEM je tato hranice použitelnosti až od 

měřítka 1:500 000. Přesto lze DEM použít např. pro mapování nedostupných oblastí, 

kdy je tato přesnost dostatečná. 

 Jak bylo zjištěno, velikost buňky rastru na přesnost výškopisu neměla 

prakticky žádný vliv. Je to způsobeno především velikostí řešeného území. Pokud by 

bylo zájmové území větší, jistě by se tento faktor projevil. Podle Kienzle (2004), je 

pro území cca 15 km2 s proměnlivým sklonem nejvhodnější velikost buňky 5 – 20 m. 

Tato analýza byla prováděna v Kanadě ve státě Alberta. Kde byla zkoumána 4 různě 

členitá území.   
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10 Závěr 

 Cílem této diplomové práce bylo vyhotovení geodetické a prostorové 

dokumentace úseku Zlaté stezky za použití nástrojů GIS a porovnat vyhotovené 

modely terénu ohledně jejich representativní schopnosti a přesnosti. 

 Potvrdilo se, že pozemní měření, jakožto získávání dat pro tvorbu DMT, je 

v současné době sice stále nejpřesnější, ale zároveň nejnáročnější metodou, ať po 

stránce finanční nebo časové. Dále bylo zjištěno, že pro tvorbu přesného DMT 

zaměřeného úseku Zlaté stezky je sice vhodný model TIN, neboť vstupem jsou 

měřená data bez jakýchkoliv úprav, avšak pro realističtější ztvárnění terénu je lepší 

použít model rastrový. Při porovnávání přesnosti jednotlivých DMT s naměřenými 

daty, byla potvrzena domněnka o horší kvalitě výškopisu ZABAGED®.  

 Výsledná vizualizace území pomocí 3D modelu, který vznikl spojením 

naměřených dat a DMR 4G, je konečným výstupem této diplomové práce. Tímto 

způsobem lze presentovat jakékoliv území či objekt na Zemi. V současnosti se 3D 

modely území velice často používají např. při presentaci urbanistických studiích, kdy 

si i každý dokáže představit rozmístění zástavby lépe nežli při pouhém pohledu na 

plán.  

.  
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